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Copyright Notice 
 

You may not reproduce, transmit, transcribe, store in a retrieval 

system or translate into any human or computer language this 

manual and software. These actions, in any form or by any 

means, are illegal without the express written permission of  

Puritas Springs Software. 
 

 

Limited Warranty 

 

During the period of time before a major upgrade, if the disks that make up the then-current 

version of this software are defective, then return the software to Puritas Springs Software, 

645 McKee Trail, Hinckley, Ohio 44233-9209 and replacement disks will be mailed to you. 

Puritas Springs Software reserves the right to define and decide what constitutes a major 

upgrade. 
 

 

Disclaimer & Limitations 
 

Puritas Springs Software provides Uniform Domestic Relations Forms (UDRF) for Win-

dows, consisting of both the software and this manual, "AS IS." The software and manual 

carry no warranty as to performance, merchantability or fitness for any particular use. Puri-

tas Springs Software specifically disclaims all warranties, express or implied, regarding the 

software or our services, and Puritas Springs Software does not warrant that the software 

or services are free from defects, interruption, errors or other program limitations. For states 

containing limitations on implied warranties, any such implied warranties are limited to 60 

days from the date of purchase. The rights provided by this Limited Warranty shall be lim-

ited to the original, registered and recorded purchaser of the software. Said rights are limited 

to the cost of the software and are non-transferable. You assume all liability and responsibil-

ity for the accuracy of any form produced by this software. Recognizing this, Puritas 

Springs Software has exercised due care in the preparation of the software and manual. In 

no event, however, shall the authors or publisher be liable for direct, incidental or conse-

quential damages, or damages of any type, arising from the use of UDRF for Windows. 

 

This Agreement sets forth Puritas Springs Software’s entire liability and your exclusive 

rights and remedy with respect to the software. Headings are included for convenience and 

shall not be considered in interpreting this Agreement. This Agreement does not limit any 

rights that Puritas Springs Software may have under trade secret, copyright, patent or 

other laws, federal or state. 
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Uniform Domestic Relations Forms  (UDRF) is 

a 32-bit Windows application that runs in Win-

dows 7, Vista, XP, 2000, ME, and Windows 

98. 

 

System Requirements. Generally, if you have 

computer that’s equipped to run any of the op-

erating systems listed above, you won’t need to 

be concerned about UDRF’s system require-

ments. However, if it’s an issue, UDRF re-

quires a Pentium or equivalent processor with 

at least 64 MB of RAM. UDRF comes on a compact disk (CD) and requires be-

tween 4 and 12 megabytes of hard disk space. UDRF requires an SVGA video card 

capable of displaying a minimum of 256 colors at a minimum 800 x 600 resolution. 

UDRF works with any Windows-compatible printer. A larger resolution works bet-

ter for viewing the various worksheet screens. 

 

COPYRIGHT NOTICE. United States copyright laws protect UDRF as the prop-

erty of Puritas Springs Software. Your UDRF distribution disk contains a regis-

tered serial number that is hidden in various places inside the software. Possessors of 

unauthorized copies violate Federal law. 

 

In General. The UDRF distribution CD contains many files, some of which are 

shown below. You don't need to know anything specific about them. The instal-

lation program automatically transfers them to your hard drive and UDRF uses them 

during program operation. The list below is for reference only. 

 

These files are essential to the proper operation of UDRF. If any of these files be-

comes corrupted or relocated, you must reinstall UDRF from the CD. In most in-

stances reinstallation will require removing the program prior to re-

installation. To learn more about re-installing, see the applicable section on page 6 

of this manual. The removal/re-installation process will not affect your client UDR 

data files. Naturally, you should back up the data directory (Files) periodically to 

protect your client data. 

 

 
URDF.EXE is the executable file that represents the UDRF program; 
 
URDF.HLP is a file that is used by UDRF’s on-line help system. It must 

always be in the same directory as the executable file; 
 
URDF.UDR is a necessary file that seeds any new client file you create. 

It must be located in the .UDR client file directory, usually 
C:\Puritas\UDRF\Files. It should be modified by the user so it 
contains the personalized startup values for URDF, i.e., at-

Removing 

Before 
Reinstalling 

Getting Started 
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torney’s name, address, telephone number and Supreme 
Court registration number. 

 
PAGEXX.DAT are a series of files numbered 1 through X that are used 

internally by UDRF to define the characteristics of the data 
that is printed on the forms. 

 
PAGEXX.RTF are a series of files numbered 1 through X that are used 

internally by UDRF to generate the forms that are displayed 
on your screen and sent to your word processor. 
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Overview 
 

Install Uniform Domestic Relations Forms  

(UDRF) to your computer by following the 

instructions below. 

 

In the case of non-network installations, we 

recommend installing UDRF in the default di-

rectory (C:\Program Files\Puritas\UDRF\).  
 

Network Installation 
 

In the case of network installations, the types and implementations are diverse and 

we cannot give network-specific technical support although we answer questions 

about UDRF to assist network administrators during installation and setup. You will 

not be able to install or configure UDRF for networks unless you purchased a multi-

user or network license. 

 

Installation Steps 
 

In General 
 

Before starting the installation, we should mention that the files on the distribution 

CD are compressed, and therefore, you must “install” UDRF  to your computer 

rather than simply copying the files from the CD to your hard drive. For that same 

reason, you cannot run UDRF  from the CD. You must install UDRF to your hard 

drive. 

 

Installation Steps 

 

A. Place the distribution disk in your drive. 

 

B. The following three steps start the installation process: 

 

1. Press the Start button; 

 

2. Click on the Run item; and 

 

3. Type the command shown below. Note that not all DVD/CD players 

are designated as drive D, so if you’re installing from a different 

drive, you must use the correct drive letter. Always use the DVD/CD 

drive with the lowest drive letter. 

D:SETUP.EXE 

Installation 
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C. The Setup progress meter will appear until the Welcome dialog appears. Click 

the Next button to proceed with installation. Click Cancel if you want to abort 

installation. 

 

D. The Puritas Springs Software Licensing Agreement appears in the next dialog. 

Press the Yes button to accept the terms and conditions of the license and con-

tinue with the installation. If you do not agree to the terms of the Licensing 

Agreement, you will not be able to continue installing the program. 

 

E.   Verify your user identification information and click the Next button. 

 

F.   Verify the installation directory. We strongly recommend C:\Program 
Files\Puritas\UDRF\ which is the default. If you want to use an alternate in-

stallation directory or drive, you can use the Browse button to make your selec-

tion. Click the Next button to continue. 

 

G. The next dialog, the Select Program Folder dialog, lets you select the program 

folder. The default answer is “Puritas Springs Software”. Click on the Next but-

ton to continue. 

 

H. Verify the database or client file directory. We strongly recommend 

C:\Puritas\UDRF\ which is the default. If you want to use an alternate installa-

tion directory or drive, you can use the Browse button to make your selection. 

Click the Next button to continue. 

 

I. The installation begins when you click the Next button in the Start Copying Files 
dialog. A progress meter will keep you informed as the program files are trans-

ferred from the DVD/CD to your hard drive. 

 

J. When the entire installation process is complete, the Setup Complete dialog ad-

vises you that the installation process was successfully completed.  

 

Running UDRF 

 

You start UDRF  by clicking on the UDRF  icon that is on your desktop or by click-

ing the Start button, selecting the Programs submenu, then the Puritas Springs 
Software submenu and finally selecting the UDRF  item. You can also double-click 

on any .UDR file and UDRF  will start and automatically open the UDR file. 

 

Updating and Reinstallation 
 

If you wish to download a free upgrade from our web site (www.puritas-

springs.com), please read this section. 

 

1. Download the Upgrade. 

A. Click on UDRF ’s Help menu and select Download Upgrade. 
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B. In the Download Upgrade dialog box, click on the Check Availability but-

ton. Note that some systems, typically networks, may have security software 

and/or hardware in place that prohibit downloading executable files. If this is 

true in your office or you are having problems with the download, check 

with your network administrator. 

C. After clicking the Check Availability button, you may get one of three re-

sponses. 

1) You are notified that a newer version is available and the Check Avail-
ability button changes to a Download Upgrade button. Click on 

Download Upgrade button and see the file downloading. 

2) You are notified that there is no newer version available, in which case, 

you’re done. 

3) A message indicates an error, i.e., “HTTP Get Failed.” Talk with your 

network administrator or send in your disk according to our instructions 

on the Current Versions page of our web site: www.puritas-
springs.com. 

2. Remove UDRF . First, it is important to know that removing the UDRF 

program using Windows’ Add/Remove function will not delete or harm 

your client files. That being said, you should always back up the Files subfolder 

that is contained within the UDRF program folder. It is there that your client 

files are stored. The default path is C:\Puritas\UDRF\Files\. Here are the steps 

for removing the prior version of UDRF. The exact procedure will differ from 

one version of Windows to the next, but the basics are the same. 

A. Exit the UDRF program. 

B. Click on the Start button. From the Start menu select Settings, and then 

Control Panel. Note that in some Windows versions, you may need to navi-

gate to Control Panel in a different way. However, once in Control Panel, 
double-click the Add/Remove Programs icon. If you don’t see the Add/
Remove Programs icon, you may need to click on the Classic View link 

or option. Note that in later versions of Windows the “removal” process is 

referred to as “uninstalling.” 

C. Select UDRF from the program list within the Install/Uninstall tab. With the 

UDRF item highlighted, click the Add/Remove button. 

D. When the Welcome dialog appears, click the Next button to begin the re-

moval process. 

E. The next dialog box to appear is titled Program Maintenance. Click the  

button next the Remove item, and then click the Next button. 

F. Remove the Program is the next dialog box to appear. The InstallShield 

Wizard will begin to remove the old UDRF  program when you click the 

Remove button. 

G. You are notified when the removal function is complete. In the dialog box 

that appears, click the Finish button to close the InstallShield Wizard 
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3. Install the New Version. The final step in the upgrade process is to install the 

new version by executing the file you downloaded. The name of the downloaded 

file is setupudrf.exe (note that sometimes the exe extension is hidden) and it is 

located by default at C:\Puritas\UDRF\Files. Note that if you changed the loca-

tion of the client file folder (referred to by InstallShield as the “Database” 

folder), you’ll find the downloaded executable (setupudrf.exe) at that location. 

When you find the file, double-click on it and follow the installation instructions 

contained on page 5 of this manual. If you don’t know how to find the file AND 

it’s in the default location because you have not changed that parameter, try fol-

lowing these steps: 

A. Go to My Computer 

B. Double-click the C:/ or Local Hard Drive icon. 

C. Double-click the Puritas folder. 

D. Double-click the UDRF folder 

E. Double-click on the Files folder 

You should see the setupudrf.exe file. Double-click on it to begin the installation. 
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Uniform Domestic Relations Forms (UDRF) 
starts by displaying the Main Window. After 

you get to know UDRF, you’ll discover that 

you can display and complete any form or 

worksheet in any order. For now, however, and 

in most instances, it is best to follow the logic 

and organization of the Main Window.  

 

Before getting into the actual steps involved in completing the affidavits, it’ll will 

help to understand a bit more about the Main Window and how it can help make 

completing forms and understanding program operation a lot easier. 

 

The Main Window

The Tree View & Help Pane of the Main Window 
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Overview 

 

Tree View. The pane on the left side of the Main Window contains a tree view of 

all the affidavits and most of the important functions in UDRF. You should be fa-

miliar with the look and feel of the tree view because it is a standard Windows com-

ponent. You may recognize it as part of the Windows Explorer user interface. You 

can do two things in the tree view – click on nodes or click on items. Also, if you 

ever cover the Main Window with a form and wish to see it again, you can click on 

the Main Window button on the tool bar or use the Display menu's Main Window 

command. The vertical divider that separates the left window from the right can be 

dragged horizontally to adjust the relative sizes of these windows to your liking. 

 

Nodes. Nodes are the [+] or [-] buttons you see in front of certain items in the tree 

view. The [+] sign means that there are elements or subitems hidden within that 

item. You can view or expand the subitems by clicking on the [+]. When you do, 

you'll see the list of subitems and the [+] will change to a [-]. If you wish to collapse 

or hide the subitems, click on the [-]. Note that when you expand an item, its 

subitems may also have subitems. Even those subitems can have subitems. There's 

no limit to subitems in the tree view. You can see all of the items at the same time 

by right-clicking your mouse in the tree view and selected Expand Tree View from 

the pop-up menu. 

 

Items. Clicking on the items will display either (1) a relevant instruction page in the 

right-side window pane, or (2) a particular page of an affidavit that you wish to view 

or complete. 

 

Start Here. As mentioned earlier, even though you can click on any item in any or-

der, we've arranged the first level of subitems in a top-to-bottom order that logically 

organizes the data entry process. Click on the [+] to the left of the Start Here item 

to begin. You'll see the first level of subitems: 

 

1. General Information 

This single form contains repetitive background information. The sort of in-

formation you'd like to print and staple to the inside cover of your client file. 

Basic case information, party information, and child info. The information 

you enter on the General Information form is used again and again as 

UDRF automatically completes the desired affidavits. 

 

2. Name & Save File 

The rule about saving your file is — early and often. Having just completed 

the General Information Worksheet, now is a good time to name your file 

and save your work. UDRF will save your client file in the location set for 

UDR files on the Options menu. This location is set during installation and 

by default is: C:\Puritas\UDRF\Files. 

 

3. Displaying Forms 

This item contains an expandable hierarchy that contains a link to all the 

forms, schedules, letters and other documents contained in UDRF. It paral-
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lels the Display menu. Note that if you’re jumping to particular page of an 

affidavit, it’s often quicker to use the Display menu. This avoids needing to 

return to the Main Window and then using the Paging buttons on the tool 

bar to find the target page. The Paging button(s) are on the tool bar at the 

top of the page and contain a left or right-facing red arrow. There’s not much 

to add to this step of the form completion process. The form you select ap-

pears on your screen and you tab from field to field typing your answers as 

you go. Note that a few fields, like Totals for example, complete themselves 

and you cannot tab to those fields. 

 

4. Save File 

This it the “often” part of the “early and often” saving rule. At this point 

you’ve done more work in the file and this a reminder to save your additions. 

You won’t see much happen because the save happens very quickly. The file 

already has a name (from Step 2), so the Save As dialog will not appear. 

 

5. Printing Forms 

Clicking on this item takes you to the Print Selected Forms dialog from 

which you can print any single form or batch of forms. There are no subitems 

with respect to this item. 

 

6. Sending Forms to Your Word Processor 

Clicking on this item presents the Send Selected Forms dialog from which 

you can send any single or batch of pages/affdiavits to your word processor. 

There are no subitems for this item. UDRF works best with Microsoft's 

Word for Windows, but can be used with most word processors capable of 

handling rich text format (RTF) files. When it ships, UDRF is set to use 

Word for Windows. If you use a different word processor, you can go to the 

Options menu's Set Word Processor function to make the necessary ad-

justment. 

 

Getting Started. Assuming you've already clicked on the node [+] to the left of the 

Start Here item, you're ready to start on a file now. Click on the General Informa-
tion item to display the General Information Worksheet. 
 

Finally 
 

Upgrades. Note that we do add features and make fixes periodically as mat-

ters are reported to us and therefore, you are encouraged to periodically use 

the Download Upgrade feature on the Help menu to obtain any up-to-date 

program changes. 

 

Dates. In some instances where dates are involved, UDRF provides a con-

venient pull-down, date picker. If you prefer, you can still enter a date by 

hand, but make certain to use 4 digit years, i.e., "1985" instead of "85." Also 

note that you can change the year by clicking on the year at the top of the 

date-picker drop-down. The same is true of changing the month. 
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Print This Page. This, and any other instruction page, can be printed by 

clicking on the Print button on the upper tool bar. 

 

Beginning the Data Entry Process 
 

As explained above, entering client information involves the following steps: 

 

1 Display and complete the General Information Worksheet; 

2 Name and Save Your File; 

3 Display and Complete the Desired Forms; 

4 Save Your Information Again 

5 Print Your Forms 

6 (Optional) View Completed Forms in Your Word Processor 

 

UDRF does all calculations and transfers data from the General Information 
Worksheet automatically and instantaneously. You can find a tutorial file on your 

hard drive as one of the installed client files named Sample.UDR. Each step is dis-

cussed in a separate topic below. 
 

Step 1. Completing the General Info Worksheet 
 

You won’t look hard to find the General Information Worksheet; it’s at the top of 

the Main Window’s tree view. You can also find it on the Display menu. When the 

General Information Worksheet first appears, the cursor is blinking in the County 
field. 

 

 With the County field active, type "FRANKLIN". For this field we like to use 

all capital letters because this is the field that shows up in the caption area of all 

the affidavits. When you are through, press the <TAB> key. 

 

 Complete the remaining fields as shown below. Press <TAB> after each entry. 

When finished, your screen should look like the one shown on the next page. We 

can't overemphasize the importance of pressing <TAB> after each entry. 

 

 Field Answer 

 ------------------------------------------------------------------------------- 
 Case Number 01-218743 

 Judge Philip T. Justice 

 Referee/Magistrate Robert D. Ludlow 

 Plaintiff/Petitioner 1 Jane T. Sample 

 … is the Affiant Check this box 

     is not the Affiant (leave unchecked) 

 Defendant/Respondent/Petitioner 2 Roger B. Sample 

 … is the Affiant (Leave unchecked) 

     is not the Affiant Check this box 

 Name of Child 1 Mary F. Sample 

 Sex of Child 1  
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 … Male (Leave unchecked) 

 … Female Check this box 

 Date of Birth of Child 1 7/4/2001 

 Place of Birth of Child 1 Columbus, Ohio 

 Child 1 Lives With Mother 

 

As you complete the General Information Worksheet there are a couple of points 

to note: 

 

1. Aside from clicking the mouse in any particular field, you can use the <TAB> 

key to move forward from field to field and <SHIFT><TAB> to move back-

wards through the fields. Get in the habit of using the <TAB> key. You must 

press the <TAB> key after making each entry. 

2. Checkboxes can be checked and unchecked by using your mouse or by using the 

spacebar on your keyboard. 

 

IMPORTANT NOTE. Now that you have worked in the file for a few minutes, 

you will want to be sure to save your client file by giving it a meaningful name. 

Select Save As from the File menu. When prompted for a name, use the client's last 

name, i.e., “Smith, Joseph” or “Miller, Thomas”, etc. Always use the ".UDR" exten-

sion; better yet, leave it off completely and UDRF will put it on for you. The rule 

about saving files is: If you haven't named the file, use the Save As command to 

give it a name. If you already named the file (i.e., Sample, Robert.UDR), use the 

Save command or the Save button. 

 

Step 2. Naming & Saving Your File 
 

Now that you have worked in the file for a few minutes and completed the General 
Information Worksheet, you will want to be sure to save your client file by giv-

ing it a meaningful name. Select Save As from the File menu. The standard Win-

dows Save As dialog will appear. In the file name input box, use the client's last 

name, i.e., “Smith, Joseph.”. It’s usually best to always use the ".UDR" extension. 

By default, files are saved at C:\Puritas\UDRF\Files. 

 

Step 3. Display and Complete the Remaining Forms 
 

For this tutorial we will select Affidavit 1, although as far as data entry is concerned, 

all of the affidavits are alike. 

 

 From the Display menu, choose Affidavit 1|Page 1. Note also that Page 1 can 

also be accessed from the tree view of the Main Window. 

 

 The caption is already complete, so you can being with the Date of Marriage 
field — that should be where the cursor is currently. This field and the next, 

Date of Separation, are true date fields with pull-down calendars for easy date 

selection. Press <TAB> to move from field to field. 
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Section I—Income is next, and the data entry process is hardly different from that 

you used in the General Information Worksheet. 
 

One point of interest are the monetary fields. Typically those fields are trapped to 

preclude the entry of non-numeric characters. This is NOT true for most of the 

monetary fields in UDRF because the rules require that you enter “EST” if the 

amount is an estimate. According to the instructions, you may not leave any 

“category” blank and must write “None” if applicable. Therefore, the monetary 

fields allow for this type of entry although any associated math should be performed 

correctly regardless. If an amount is estimated we recommend using the format: 

“EST $1,980.02.”  Even though our programs usually preclude the entry of dollar 

signs and commas in number fields, it looks better if you include them when making 

entries like the one in the example. 

 

Step 4. Save Changes 
 

You won’t see anything happen when you click on this command item in the Main 
Window, but rest assured your file is being resaved using the file name you gave it 

in Step 2. Always remember the mantra that prudent computer users implement for 

saving — early and often. 

 

Step 5. Printing the Forms 
 

This step is the easiest. Click the menu's File|Print|Selected Forms item. You'll 

see several pages of checkboxes which you can check to print. If you're looking at a 

form that you just corrected and simply wish to print the form you're looking at on 

the screen, use the Print This Form button on the tool bar at the top of the screen. If 

you want to print only the front or back of a form, use the Send to Word Proces-
sor function. You can always find a complete description of the form's number and 

name on the status line at the bottom of the UDRF window when you hold your 

mouse cursor over the form number. 

 

Step 6. Sending Forms to your Word Processor 
 

Aside from UDRF’s ability to print forms on your printer, a powerful and useful 

feature is its ability to send entire sets of forms to your word processor. In this in-

stance, UDRF doesn’t really print your forms, instead it creates an RTF file that 

your word processor can read so that when you “print” your forms, your word proc-

essor is started and the automatically-generated RTF file is opened. The purpose of 

this feature is to let the user make form and substance modifications to forms and 

data that would otherwise be impossible within the confines of the UDRF program 

itself. Microsoft developed the RTF standard so it comes as no surprise that Micro-

soft’s Word for Windows is best at reading and writing RTF files. Therefore, if you 

have MS Word, you should go to the Options menu and check that Word for Win-
dows is selected as your word processor using the Set Word Processor item. If 

you use MS Word, you should be able to print your forms with little or no adjust-

ments. 

Money 
Fields 
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WordPad. If you do not use Word for Windows as your word processor, your next 

choice of word processor may be WordPad. It is capable of reading and writing RTF 

files, however, its ability to read formatting information is somewhat lacking and 

therefore it will be necessary to set the Page Setup parameters so that the margins 

are: top=0.75”; left=0.75”; right=0.75”; and bottom=0.25”. Setting the margins is 

very important because it governs both line breaks and page breaks. It is impor-

tant to remember that every computer renders True Type fonts differently, so if inap-

propriate line breaks are ruining the format of your form or schedule, try adjusting 

the margins. Usually margins that are too small are not a problem; however, 

margins that are too big cause long text lines to break across two lines instead 

of one. This destroys the look and format of the remainder of the page. So if this 

happens near the top of a page, the whole page is affected. While Word for Windows 

gets the margin settings from the RTF file header, WordPad is unable to do so. Con-

sequently, if you’re using WordPad you’ll want to set the Page Setup parameters 

that are available on WordPad’s File menu. Note that the version of WordPad that 

comes with Windows 95 does not render line spacing and underlined tabs accu-

rately enough to generate acceptable IRS forms. Therefore, if you have Win-

dows 95 and don’t use Microsoft’s Word as your word processor, you may want 

to obtain an alternate application for displaying RTF files.  
 

WordPerfect. WordPerfect also reads and writes RTF files but its ability to do so is 

severely hampered by the fact that it miscalculates line spacing. Even if you make 

template corrections in WordPerfect, WordPerfect doesn’t seem to be able to recog-

nize its own RTF files thus rendering the otherwise excellent Reveal Codes feature 

useless. We recommend not using WordPerfect; use WordPad instead. 

 
 



16 

Ohio Uniform Domestic Relations Forms  

This paper manual is merely an outline of the basics of installation, getting started 

and information entry. You can get additional help via the program’s Help|Table of 
Contents menu. This program has context-sensitive help. That means that you get 

help on a specific menu item without searching for that topic. Simply highlight the 

menu command and press <F1>. Many other objects on your screen have associated 

help topics, i.e., window scaling. When in doubt, move focus to the component object 

and press <F1> . 

 

If you’re like us, you might be doubtful as to whether help files can be truly helpful. 

Regardless of  any drawbacks, we found them to have significant benefits over their 

paper counterpart. 

 

Help Is Always There 

When we were at the office, the manual was at home. When we were on the computer 

at home, the manual was at the office. On unfortunate occasions, that alone can make 

you lose a day. It never happens with help files. They’re always there. A copy for 

your home computer, and a separate one for the office. Ditto for your laptop! When 

you’re desperate for information, you can always count on its accessibility. 

 

Help Is Hyperlinked, Searchable & Better Indexed 

We took extra time to develop a logical system of indexing. You should find that a 

help file’s searchability can be a time-saver when you’re looking for a snatch of text. 

The point and click links between key words provide instant information without 

fumbling through page after page looking for something. This non-linear characteris-

tic is part of what makes help files so uniquely useful. 

 

Help Is Up To Date 

Because they are printed in large quantities, paper manuals fall out of synch with last-

minute or late-minor programming changes. Help files, on the other hand, are easier 

to keep current with programming changes because their modification involves no 

additional processing steps to implement (i.e., physical transportation, printing, bind-

ing, etc.). 

 

Paper Fix 

Don’t forget that any help topic can be printed simply by pressing the help window’s 

Print button, or using the menu’s Print Topic command. 
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Checking out the following help topics before dig-

ging into UDRF will help reduce the learning curve, 

although you should find UDRF relatively straight-

forward to use. 

 

1. What is the DEFAULT.UDR file? 
This topic explains how to customize the blank, start-up domestic relations affida-

vits so that common, unchanging information, i.e., county name, etc., is set up to 

appear automatically when you select New from the File menu.  

 

2. Using The Keyboard 
This is a good topic to print because it summarizes all the key commands which 

are available in the program. 

 

3. Overriding Answers 
You’ll use this command when you need to manipulate entries in text input dialogs 

that have a light-blue colored background. 

 

4. Common Questions 

If we get recurring questions about a particular facet of URDF operation, you will 

find the relevant help topic cited here. 

 

5. Tricks For Better Looking Printouts 

Tips for getting the most out of UDRF and its ability to generate printed forms, for 

example, the inventory and final accounting. 


